Copyrights

© Cypress Semiconductor Corporation, 2011-2017. This document is the property of Cypress Semiconductor Corporation and its subsidiaries, including Spansion LLC (“Cypress”). This document, including any software or firmware included or referenced in this document (“Software”), is owned by Cypress under the intellectual property laws and treaties of the United States and other countries worldwide. Cypress reserves all rights under such laws and treaties and does not, except as specifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights. If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code form, to modify and reproduce the Software solely for use with Cypress hardware products, only internally within your organization, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resellers and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress's patents that are infringed by the Software (as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware products. Any other use, reproduction, modification, translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without further notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described in this document. Any information provided in this document, including any sample design information or programming code, is provided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality and safety of any application made of this information and any resulting product. Cypress products are not designed, intended, or authorized for use as critical components in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other uses where the failure of the device or system could cause personal injury, death, or property damage (“Unintended Uses”). A critical component is any component of a device or system whose failure to perform can be reasonably expected to cause the failure of the device or system, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses of Cypress products. You shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or death, arising from or related to any Unintended Uses of Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respective owners.
Contents

1. Introduction 5
   1.1 CY8CKIT-002 Contents ................................................................. 5
   1.2 Programming .............................................................................. 5
   1.3 Debugging .................................................................................. 6
   1.4 Bridging ...................................................................................... 6
   1.5 Documentation Conventions ...................................................... 6

2. Installing MiniProg3 7
   2.1 MiniProg3 ................................................................................ 7
   2.2 MiniProg3 Installation ................................................................. 7
   2.3 Example Projects .................................................................... 8
   2.4 MiniProg3 LEDs ...................................................................... 9

3. Technical Description 10
   3.1 Interfaces ................................................................................ 11
       3.1.1 ISSP .................................................................................. 11
       3.1.2 JTAG ............................................................................... 11
       3.1.3 SWD/SWV ..................................................................... 11
       3.1.4 I2C .................................................................................. 11
       3.1.5 RX8 ................................................................................ 12
       3.1.6 Reference ........................................................................ 12
   3.2 Connectors .............................................................................. 12
       3.2.1 5-Pin Connector ................................................................ 12
       3.2.2 10-Pin Connector ............................................................... 12
   3.3 Power ....................................................................................... 13
       3.3.1 Voltage Detection ............................................................. 14

A. Appendix 15
   A.1 Troubleshooting ..................................................................... 15
   A.2 Regulatory Compliance Information ........................................ 15

Revision History 16
Safety Information

Regulatory Compliance

CY8CKIT-002 is used as a development platform for hardware or software in a laboratory. In a domestic environment, this product may cause radio interference; adequate prevention measures should be taken.

CY8CKIT-002, as shipped from the factory, is verified to meet with requirements of CE as a Class A product.

The CY8CKIT-002 boards are sensitive to electrostatic discharge (ESD). Electrostatic charges accumulate on the human body and on other equipment. Devices that are subjected to high-energy discharges can suffer permanent damage. Proper ESD precautions are recommended to prevent loss of functionality. Store unused CY8CKIT-002 boards in the protective shipping package.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that you work on the board at an ESD workstation, if available. Otherwise, use appropriate ESD protection, such as an antistatic wrist strap attached to a ground, when handling parts.
1 Introduction

The PSoC® MiniProg3 Program and Debug Kit is an all-in-one programmer for PSoC 1, PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 architectures, a debug tool for PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 architectures, and an USB-I^2^C Bridge for debugging I^2^C serial connections and communicating with PSoC devices.

Designed as a low-cost aid for developers to use in building their own systems around Cypress 8-bit and 32-bit PSoC devices, the MiniProg3 is included with the CY8CKIT-001 development kit and sold as a standalone kit, CY8CKIT-002. These kits are available through the Cypress Online Store or through our distributors.

Figure 1-1. MiniProg3

1.1 CY8CKIT-002 Contents

The CY8CKIT-002 PSoC® MiniProg3 Program and Debug Kit includes:

■ MiniProg3 programmer/debugger
■ 10-pin ribbon cable
■ USB Standard-A to Mini-B cable
■ Quick Start Guide

1.2 Programming

The MiniProg3 programmer/debugger provides the flexibility to work with different programming and debugging interfaces, such as JTAG, SWD, ISSP, and I^2^C. MiniProg3 supports all 8-bit and 32-bit PSoC devices. When programming, MiniProg3 enables communication with target devices using I/O voltage levels from 1.5 V to 5.5 V. In addition, MiniProg3 can supply power to a simple target board at one of four voltage levels: 1.8 V, 2.5 V, 3.3 V, or 5 V.
1.3 Debugging

MiniProg3 supports the following debugging protocols for 8-bit and 32-bit PSoC devices:

- SWD (PSoC 3, PSoC 4, PSoC 5LP, PSoC 6)
- JTAG (PSoC 3, PSoC 5LP, PSoC 6)
- I²C (limited PSoC 1 devices)

The MiniProg3 debugger is supported by the software tools PSoC Creator and PSoC Designer.

1.4 Bridging

MiniProg3 supports USB-I²C bridging protocols. These protocols are used for debugging certain PSoC 1 devices that support serial communication debugging, tuning, and configuration of fixed function devices. The MiniProg3 bridging capabilities are used by PSoC Designer, PSoC Creator, PSoC Programmer, Bridge Control Panel, and other applications. Tuning software tools also use these capabilities.

Note: If you want to develop your custom USB-I²C applications using MiniProg3, see the PSoC Programmer COM guide and examples of the custom USB-I²C applications.

1.5 Documentation Conventions

Table 1-1. Document Conventions for User Guides

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier New</td>
<td>Displays file locations, user-entered text, and source code: C:...cd\icc\</td>
</tr>
<tr>
<td>Italics</td>
<td>Displays file names and reference documentation: Read about the sourcefile.hex file in the PSoC Designer User Guide.</td>
</tr>
<tr>
<td>[Bracketed, Bold]</td>
<td>Displays keyboard commands in procedures: [Enter] or [Ctrl] [C]</td>
</tr>
<tr>
<td>File &gt; Open</td>
<td>Represents menu paths: File &gt; Open &gt; New Project</td>
</tr>
<tr>
<td>Bold</td>
<td>Displays commands, menu paths, and icon names in procedures: Click the File menu, and then click Open.</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>Displays an equation: 2 + 2 = 4</td>
</tr>
<tr>
<td>Text in gray boxes</td>
<td>Describes cautions or unique functionality of the product.</td>
</tr>
</tbody>
</table>
2. Installing MiniProg3

This chapter shows how to install MiniProg3 and its associated PC software.

2.1 MiniProg3

Figure 2-1. Top View

Figure 2-2. Bottom View

2.2 MiniProg3 Installation

The MiniProg3 programmer/debugger is supported by PSoC Programmer, PSoC Designer, and PSoC Creator. Secondary software, such as Bridge Control Panel and Clock Programmer, use the programmer COM hardware layer to support MiniProg3 functionality.

1. Download and install PSoC Programmer. Follow the on-screen instructions to install the software.

2. Connect the MiniProg3 to your computer's USB port using the USB cable. When properly connected, the four LEDs on the MiniProg3 flicker.

   The first MiniProg3 driver is automatically installed.

   Note: Remove the warning sticker before using MiniProg3.


   When PSoC Programmer opens, the second MiniProg3 driver is automatically installed.
4. To connect to the port, in the Port Selection window, click the MiniProg3 device. You can also click Connect/Disconnect.

If the connection is successful, the green status LEDs on MiniProg3 light up and a blue dot appears next to MiniProg3 in the Port Selection box. Also, the indicator in the lower-right corner of the PSoC Programmer window turns green and shows Connected.
You can now use MiniProg3 and the functions it supports.

For more information on how to use PSoC Programmer, see Help Topics under the Help menu in PSoC Programmer or press [F1].

2.3 Example Projects

MiniProg3 is supported by PSoC Programmer, a simple GUI that connects to programming hardware, to program and configure PSoC devices and to develop custom applications.

Example projects and documentation are included in the PSoC Programmer installation and are available in the PSoC Programmer installation directory:
<Install_Directory>\Programmer\Examples

The PSoC Programmer installation directory also includes documentation on how to use the programming interface:
<Install_Directory>\Programmer\Documents
### 2.4 MiniProg3 LEDs

MiniProg3 has five indicator LEDs that, when lit, indicate the following:

- **Upper Left - Busy** (Red): An operation (such as programming or debugging) is in progress.
- **Lower Left - Status** (Green): The device is enumerated on the USB bus. When flashing, this LED indicates that MiniProg3 has received USB traffic.
- **Upper Right - Target Power** (Red): MiniProg3 is supplying power to the target connectors. This LED does not light up if power to target connectors is supplied by a source other than MiniProg3.
- **Lower Right - Aux** (Yellow): Reserved for future use.
- **Middle - No Label** (Yellow): Flashes briefly during the initial configuration of the device. If it stays lit, this LED indicates that a configuration error has occurred. If this happens, disconnect the MiniProg3 from the USB port and then reconnect it.
3. Technical Description

MiniProg3 is a protocol translation device. With MiniProg3, the PC host software can communicate through a high-speed USB to the target device to be programmed or debugged, as shown in Figure 3-1. The device-side communication protocol can be one of the several standards and can occur over either of the two connectors. Table 3-1 lists the protocols that are supported by each connector. MiniProg3 enables communication with the target devices using I/O voltage levels from 1.5 V to 5.5 V. In addition, MiniProg3 can provide power to a simple target board, at one of four voltage levels: 1.8 V, 2.5 V, 3.3 V, or 5 V.

Figure 3-1. System Block Diagram

Table 3-1. Connectors / Communication Protocol Support

<table>
<thead>
<tr>
<th>Connector</th>
<th>ISSP</th>
<th>JTAG</th>
<th>SWD and SWV&lt;sup&gt;a&lt;/sup&gt;</th>
<th>I&lt;sup&gt;2&lt;/sup&gt;C</th>
</tr>
</thead>
<tbody>
<tr>
<td>5-pin</td>
<td>Supported</td>
<td>N/A</td>
<td>SWD</td>
<td>Supported</td>
</tr>
<tr>
<td>10-pin</td>
<td>N/A</td>
<td>Supported</td>
<td>SWD and SWV&lt;sup&gt;a&lt;/sup&gt;</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<sup>a</sup> SWV trace is available only with SWD debugging.
3.1 Interfaces

3.1.1 ISSP

In-System Serial Programming (ISSP) is a Cypress legacy interface used to program the PSoC 1 family of microcontrollers. MiniProg3 supports programming PSoC 1 devices through the 5-pin connector only.

For more information about the ISSP interface, see the *PSoC 1 Technical Reference Manual*.

3.1.2 JTAG

The Joint Test Action Group (JTAG) standard interface is supported by many high-end microcontrollers, including the PSoC 3, PSoC 5LP, and PSoC 6 families. This interface allows a daisy chain bus of multiple JTAG devices. The MiniProg3 supports programming and debugging the PSoC 3, PSoC 5LP, and PSoC 6 devices using JTAG, through the 10-pin connector only.

3.1.3 SWD/SWV

Recent ARM-based devices have introduced a new serial debugging standard called Serial Wire Debug (SWD). The PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 device families implement this standard, which offers the same programming and debugging functions as JTAG except the boundary scan and daisy chain. SWD uses fewer pins of the device than the JTAG. MiniProg3 supports programming and debugging of PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 devices, using SWD through the 5-pin or 10-pin connector.

The Single Wire Viewer (SWV) interface, also introduced by ARM, is used for program and data monitoring, where the firmware may output data in a method similar to “printf” debugging on PCs, using a single pin. MiniProg3 supports monitoring of PSoC 3 and PSoC 5LP firmware, using SWV, through the 10-pin connector and in conjunction with SWD only.

The PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 devices support the SWD programming through the SWD lines. Before programming a PSoC 3, PSoC 4, PSoC 5LP, or PSoC 6 device, make sure you review the electrical connection requirements in the respective device datasheet or in the PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 device programming specifications. You can find the datasheets and programming specifications here:

- www.cypress.com/PSoC3
- www.cypress.com/PSoC4
- www.cypress.com/PSoC5LP
- www.cypress.com/PSoC6

3.1.4 I²C

A common serial interface standard is the I²C standard. It is mainly used for communication between microcontrollers and other ICs on the same board, but can also be used for intersystem communications. MiniProg3 uses an I²C multimaster host controller that allows the tool to exchange data with I²C-enabled devices on the target board. For example, this feature may be used to tune the CapSense® designs.

When MiniProg3 is configured in the I²C protocol mode, it enables the internal 5.6-K pull-up resistors on the SDA and SCL lines.
3.1.5 RX8
UART is another common serial interface standard. MiniProg3 uses UART (RX8), which allows the tool to receive the data from UART (TX8)-enabled devices on the target board. Refer to the “RX8 Example (MiniProg3)” section in the Bridge Control Panel Help document for more details.

3.1.6 Reference
For more information on the PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 JTAG, SWD, and \( \text{I}^2\text{C} \) interfaces, see the PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 Technical Reference Manuals. For more information on PSoC 1 interfaces, see the PSoC 1 Technical Reference Manual.

3.2 Connectors

3.2.1 5-Pin Connector
The 5-pin connector is configured as a single row with a 100-mil pitch. It is designed to mate with a Molex model 22-23-2051 (straight) or 22-05-3051 (right angle) male header with a key tab.

Figure 3-2. 5-Pin Connector with Pin Assignments

3.2.2 10-Pin Connector
The 10-pin connector is configured as a dual row with 50-mil pitch. It is used with a ribbon cable (provided) to mate to a similar connector on the target board. The recommended mating connectors are the Samtec FTSH-105-01-L-DV-K (surface mount) and the FTSH-105-01-L-D-K (through hole) or similar connectors available from other vendors. The signal assignment is shown in Figure 3-3.

When programming JTAG devices, note that MiniProg3 does not support nTRST pins.
Figure 3-3. 10-Pin Connector with Pin Assignments

Here is a summary of the protocols and related pin assignments.

Table 3-2. Communication Protocol Pin Assignments

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Signal</th>
<th>5-Pin</th>
<th>10-Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISSP</td>
<td>SCLK</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SDAT</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XRES</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>JTAG</td>
<td>TMS</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TCK</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TDO</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TDI</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XRES</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>SWD / SWV</td>
<td>SDIO</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>SCK</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>SWV(^a)</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XRES</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>I(^2)C</td>
<td>SCK</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SDA</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

\(^a\) SWV trace is only available in conjunction with SWD debugging.

3.3 Power

The MiniProg3 requires a connection to the VDDIO supply of the target device to set the voltage level used for communication. This is required regardless of the communication protocol and the port selected. One of the connector’s VTARG pins must be connected to the VDDIO supply of the target device. For PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6, this is the VDDIO1 supply because this supply is used to drive the debug pins. If you do not connect the VTARG or you connect it to the wrong supply, MiniProg3 cannot communicate with the target device.

On boards where there is a single power supply for the entire board, MiniProg3 can, in some cases, supply power to the board. This supply is limited to approximately 200 mA, and is protected against excess current draw. You can select 1.8 V, 2.5 V, 3.3 V, or 5 V for the power supply voltage. The 5-V

Note: The ribbon cable connector extends beyond the body of the connector. Be sure to allow room.
supply may be as low as 4.25 V or as high as 5.5 V, because it is supplied directly from the USB port. **Note:** Some PSoC device families do not support 5-V operation. Refer to the respective device datasheet for supported voltage selection.

**Note:** When the target voltage is set to 5 V in PSoC Programmer or PSoC Creator, MiniProg3 provides SCLK and SDAT signals at 3.3 V.

In addition to supplying power, MiniProg3 can also measure voltage on its VTARG line. The PSoC Programmer GUI displays the VTARG voltage in the **Status** group box (shown in Figure 2-3 on page 8). The accuracy of the measurement is 80–100 mV in the VTARG range 0 ≤ U ≤ 4.0 V, and a maximum of 200 mV in the range 4.0 ≤ U ≤ 5.0.

**Note:** Although ADC resolution in MiniProg3 is 20 mV, the actual accuracy is approximately 200 mV.

Some users may need to add series resistance on the VTARG domain of the target board. **Table 3-3** provides the maximum series resistance values for different voltage levels. Exceeding these values will result in an unreliable communication link.

**Table 3-3. Maximum Series Resistance on VTARG Domain on Target Board**

<table>
<thead>
<tr>
<th>VTARG</th>
<th>LIMIT</th>
<th>VIH</th>
<th>DROP</th>
<th>MAX_SERIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.0 V</td>
<td>0.9*VTARG</td>
<td>4.50 V</td>
<td>0.500 V</td>
<td>500 ohm</td>
</tr>
<tr>
<td>3.3 V</td>
<td>0.9*VTARG</td>
<td>2.97 V</td>
<td>0.330 V</td>
<td>330 ohm</td>
</tr>
<tr>
<td>2.5 V</td>
<td>0.9*VTARG</td>
<td>2.25 V</td>
<td>0.250 V</td>
<td>250 ohm</td>
</tr>
<tr>
<td>1.8 V</td>
<td>0.9*VTARG</td>
<td>1.62 V</td>
<td>0.180 V</td>
<td>180 ohm</td>
</tr>
</tbody>
</table>

### 3.3.1 Voltage Detection

MiniProg3 can detect voltages in the range of 0 V to 5 V. Many of the Cypress software tools, such as PSoC Programmer and Bridge Control Panel, display this detected voltage in the application GUI.
A. Appendix

A.1 Troubleshooting

If you experience difficulty with your MiniProg3, see the following table to correct the problem.

Table A-1. Troubleshooting Guide

<table>
<thead>
<tr>
<th>Problem</th>
<th>Try</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED does not blink upon power on.</td>
<td>Make sure the MiniProg3 USB cable is properly attached to both MiniProg3 and the computer. If you are using a hub, make sure that the hub is properly attached to both MiniProg3 and the computer. If you are using a self-powered hub, the power must be properly connected. Bus-powered hubs are not recommended.</td>
</tr>
<tr>
<td>No Windows USB plug-in sound.</td>
<td>Make sure that your computer’s sound is properly configured. If you are using a hub, try to disconnect and reconnect the hub into the computer. If it is a powered hub, disconnect the power and reconnect it while the hub's USB cable is disconnected from the computer.</td>
</tr>
<tr>
<td>Yellow light in the center of MiniProg3 stays on after connecting MiniProg3 and after launching PSoC Programmer or PSoC Creator.</td>
<td>This indicates a configuration error. Run PSoC Creator or PSoC Programmer and try to disconnect and reconnect MiniProg3. If the yellow light persists, verify that the USB cable is in good condition, and that it is a high-speed certified cable. If the condition still persists, call technical support.</td>
</tr>
<tr>
<td>Intermittent programming or debugging failures.</td>
<td>Try reducing the serial clock rate. Verify that the USB cable is in good condition, and that it is a high-speed certified cable. If the condition still persists, call technical support.</td>
</tr>
<tr>
<td>MiniProg3 is plugged in and the LED lights have flashed but nothing is happening.</td>
<td>Launch a development tool, such as PSoC Programmer, PSoC Creator, or PSoC Designer.</td>
</tr>
<tr>
<td>MiniProg3 is the *A version and the 5-pin and 10-pin connectors are connected to the device.</td>
<td>There is a known issue with the *A version of MiniProg3 that was fixed in the *B revision. If you have a *A programmer, then connect to the device individually when programming. (The MiniProg3 revision, either *A or *B, is shown on the sticker on the back of the device.)</td>
</tr>
</tbody>
</table>

A.2 Regulatory Compliance Information

The CY8CKIT-002 complies with the CE-Low Voltage Directive 2006/95/EC (Europe) safety requirement. It has been tested and verified to comply with the following electromagnetic compatibility (EMC) regulations.

- CISPR 22 - Emissions
- EN 55022 Class A - Immunity (Europe)
- CE Declaration of Conformity
## Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>ECN#</th>
<th>Issue Date</th>
<th>Origin of Change</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>**</td>
<td>3371666</td>
<td>09/19/11</td>
<td>WBZ / RAVG</td>
<td>Initial Release.</td>
</tr>
<tr>
<td>*A</td>
<td>3421613</td>
<td>11/01/11</td>
<td>WBZ / RAVG</td>
<td>Safety Information section added. Appendix A Troubleshooting guide updated</td>
</tr>
<tr>
<td>*B</td>
<td>3616863</td>
<td>5/10/12</td>
<td>ANDI / LRDK</td>
<td>Information about accuracy and resolution of measured voltage added to Power section</td>
</tr>
<tr>
<td>*C</td>
<td>3726686</td>
<td>08/28/12</td>
<td>AESA</td>
<td>Updated template and changed installation path</td>
</tr>
<tr>
<td>*D</td>
<td>3783535</td>
<td>10/10/12</td>
<td>RRAM</td>
<td>Reorganized the Appendix section</td>
</tr>
<tr>
<td>*E</td>
<td>3947113</td>
<td>03/25/13</td>
<td>SASH</td>
<td>Updated Table 2-1 on page 9. Updated Technical Description chapter on page 10.</td>
</tr>
<tr>
<td>*G</td>
<td>4525559</td>
<td>10/06/2014</td>
<td>JFMD</td>
<td>Sunset review; no content update.</td>
</tr>
<tr>
<td>*H</td>
<td>5683812</td>
<td>04/07/2017</td>
<td>SRDS</td>
<td>Updated the title to CY8CKIT-002 PSoC® MiniProg3 Program and Debug Kit Guide</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Added reference to PSoC 6 throughout the document. Added section &quot;RX8&quot; on page 12.</td>
</tr>
<tr>
<td>*I</td>
<td>5980454</td>
<td>11/30/2017</td>
<td>PMAD</td>
<td>Sunset review; no content updates.</td>
</tr>
</tbody>
</table>